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Introduction

e [TS Administrative Services New employees — Heather
Duren, Debora Exum, Robert Prescott, Dave Register,
Natalie McCarley, Kristi Bradshaw(coming soon)

e Calling all additional resources:
- More engagement with Institution resources
- Including more resources from Administrative
Services Production Support Team
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Upcoming Activities

 Grants and Hyperion Demonstration
e Thursday December 11 at ITS in Athens

— Hyperion in the morning
— Grants Suite in the afternoon



Upcoming Activities

e |nstitutional Readiness Web Conferences
— December 16t 10:30 a.m.
— January 20t 10:30 a.m.



Training Approach & Timeline

e Two primary approaches
— Full module training for ePro and Expenses
— Delta training for all other modules

 Two primary audiences

— Super users and administrators

— Trainers



Training Approach & Timeline

e Delivery methods
— Pre-recorded videos
— Live virtual training
— Classroom instruction
 Timing — Short term (upgrade)
— March 2015 - Training for all modules



Training Approach & Timeline

* Timing —Long term
— Recent CAO meeting ongoing training was
prioritized very high

— April through May 2015 — ongoing evaluation and
feedback

— Long term training for modules



Significant Application Changes

* AP Pay Cycles - Bl Publisher Checks

— Ability to print comments on payment advice.
— PDF check files will eliminate need for SwiftView.

— Signatures:
e Signature cards will no longer be needed.

 |nstitutions will be able to upload a signature image in
PeopleSoft to the server.

— Check files will be available in Report Manager
instead of Process Monitor.



Significant Application Changes

e AP Pay Cycles — ACH/EFT Notifications

— New step in pay cycle that will create email
notification to payee.

— Payment advice will be attached to the email that
includes the payment details (Invoice number,
Invoice Date, Voucher ID, etc.).
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To:
Supplier Name:
Supplier Address:

Payment Advice

AUTOMATED CLEARING HOUSE - CONFIRMED
54032 23 MILE ROAD

CHESTERFIELD MI, 48047

USA
Payment Information
Payment Reference: 005014
Payment Date: 08/19/2014
Payment Method: Automated Clearing House
Bank ID Bank Name
Bank To Information: 0322 cibc
Bank To Account: w231
JASON TESTING 123456
Invoice Number Invoice Date  Voucher ID Gross Amount
asdf3r3af 08/19/2014 00000262 120.00

Total: 120.00

19 August 2014 14:49:09 PM
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Reference Information
Pay Cycle: FG1
Pay Cycle Seq Number: 33
Branch ID Branch Name
15823
Discount Taken Late Charge Paid Amt
0.00 0.00 120.00
0.00 0.00 120.00 USD




Significant Application Changes
* AP Pay Cycles — Positive Payment

— New BOR Positive Payment page (no more issues
“No Pos Pay pay cycles available”).

— Will have the flexibility to run after each pay cycle
or at the end of the day for all check payments.

— Will continue to have multiple formats available.

 New format for Synovus will be added.



Significant Application Changes

* Project Ledger Configuration

— Configuration changes will take advantage of new
functionality in 9.2 that allows the project field to
be set as ‘Optional’ on the Budget Definition

— Institutions will be able to budget projects in
APPROP and ORG



Commitment Control Ledger Configuration

Expense - Current
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Anything with a
project_id, so both
projects and grants
are tracked here



Commitment Control Ledger Configuration

Expense - Proposed
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Significant Application Changes

Budget Reference:

* Plans underway to remove the BOR modification that
syncs the Budget Ref field to Budget Period.

e Currently working on developing new monitoring
tools (workflow, alerts, etc.) to provide the
institutions.

e A one hour WebEx is being scheduled to demo this
application change and the new monitoring tools.



Workflow Changes
e New 9.2 Workflow:

— Accounts Payable Approval — 2 levels

e Asset and Budget Reference

— Purchasing Approval — 3 levels

e Asset, Budget Reference and Buyer

— Commitment Control Budget Journals
e One Level of Approval for all Budget Journals
e Alert for Budget Reference



Workflow Changes

Changes to currently used Workflow:

— ePro (2 new paths)
e Amount — Total Requisition Amount
e Budget Reference Approval

— Journal

* One Level Approval for All Journals
e Alert for Budget Reference

ITS will send out Workflow documents this week.
Institutions need to select the levels they wish to

implement for each module and send to Shelia Sloan
by Friday, December 5th.



Security Updates for 9.2
e |TS is sending out (December 8, 2014):
— Updated Job Aids by Job Functions
— Updated Security Request Form

— A list of the 9.2 delivered roles so that the local security
administrator can begin mapping old roles to new or
updated roles.

* Continue regular security reviews and monitor
terminated user access.

e UAT - local security administrators can make
security updates for their users

— (add/delete roles, job function changes, etc.).



Pre-Upgrade Cleanup

 ePro and Expenses

— For institutions using ePro and Expenses, we will
look at cutoff options like we use during Fiscal
Year-End to restrict entry after a certain date.

e Date TBD



Pre-Upgrade Cleanup

e ePro/Purchasing

— Approve or close requisitions and Purchase Orders
— GFM Purchase Orders dispatched
— GFM elnvoices built into Vouchers and paid



Pre-Upgrade Cleanup

e Assets

— Interface items cannot be in a Pending status.
Must be run through transloader or placed in an
On Hold status.

— AM Cleanup instructions delivered to Institutional
Coordinators on 11/12/2014.

e Deadlineis 12/01/2014
— Continue monitoring on a monthly basis.



Pre-Upgrade Cleanup

e AP Vouchers:

— Vouchers should be matched and budget checked.
— Vouchers should be posted.

e AP Pay Cycles/Payments:

— All Pay cycles must be in a completed status.

* Including Positive Payment

— Payments should be posted.



Pre-Upgrade Cleanup

e Journal Generate

— All AP accounting entries (vouchers and
payments)

— All Expense module accounting entries
e Journals
—Must be approved and fully processed



Pre-Upgrade Cleanup

 General Ledger

— Journals must be approved and fully processed.



Pre-Upgrade Cleanup

 Expense Module - Significant changes
— New Expense Types and configuration changes
— We will need to treat this like fiscal year-end

— All Expense Transactions will need to be fully
processed prior to upgrade beginning:

e Travel Authorizations

e Cash Advances
* Expense Reports



Printing - Travel Authorizations, Cash
Advances and Expense Reports

e Travel Authorizations and Cash Advances do not have
delivered Bl Publisher reports.

— There is a printable view that can be printed instead.
— Online review and approval

— Usage of attachment functionality

 Expense Reports will be available as a Bl Publisher
report for printing.



Printable View
Employee Self-Service >
Travel and Expenses >
Travel Authorizations >
View > View Printable
Version

Favorites Main Menu Employes Self-Service Travel and Exp Travel Auth View
Home Woridist Add to Favorites
AN Search Advanced Search Last Search Results

To print this report. phaase use your browser's print feature

PeopleSoft.

Travel Authorization
Report Date 11182014

Lucero Aradillas Report Time 8:50:224M
Authorization ID 0000422101 Employee ID 0243120
Description HACU Conferance Status Denied
Business Purpose Afend Conference
Date From 10042014 To 10082014

Comment | will be attending the Hispanic Association of Colleges and Universities (HACU)
from October 4th to Cctober Gth. | will leave Sam on October 4th and retum late

evening past 10pm
Date Expense Type Merchant Amount Description

10042014 Emp Breakfast 11.00 USD DENVER
10042014 Emp Lunch 1800 USD  DENVER
100572014 Emp Breakfast 1.00USD DENVER
10022014 Emp Breakfast 11.00 UsD DENVER
10042014 Emp Dinner 34.00 USD DENVER
10052014 Emp Lunch 1600 USD  DENVER
10082014 Emp Lunch 1600 USD DENVER
100572014 Emp Dinner 34.00 UsSD DENVER
10022014 Emp Dinner 34.00 USD DENVER
10042014 Emp Lodging 39500 USD  DENVER
1004/2014 Emp Baggage S000USD  DENVER
10042014 100.00 USD DENVER
10042014 Emp Ar Transportation Delta Arines 1.00000 USD DENVER

Total 1,731.00 USD

Non-Reimbursable Expenses 1.731.00 USD

Total Authorized 000 UsD

| certsfy that the information provided above is an accurate estmate of travel-related costs that are to be
incummed by me.

Empicyee Signature Date

Sign out




Printable View
Employee Self-Service >
Travel and Expenses >
Cash Advances > View >
View Printable Version

Print

Favorkes  Main Merw Emgloyee Seif-Service  Travel and Expenses

To print this repon, please use your Drowsers print feature
PeopleSoft.

Cash Advance
Kevin Bryant

Advance ID 0000204001

Description Sery Debate Toumament
Business Purpose Atend Meetings
Raferance Number

Advance Source Description
Employes Advnoe Check = _—
Payments Semy Devate Aovance

Cash Afvences  Print

Report Date 09152014
Report Time 3:21311PM

Empl ID 0266552
Status Reconciled

Amount

1,205.00U80

Cash Advance Total 1,205.00 USD
Less Nonpayabie Amount 0.00 USD
Amount Due Employee 1.205.00 USD

| centify that the advance requested above will De used for authonzed purposes only

Empioyee Signature Date

Approved By Date

Page 1 of 1




Printing via Browser
View the Travel Authorization,
File > Print

View

Favorites Main Menu

View Travel Authonzafion

Page 1 of 1

Travel and Expenses - > Travel Authorization = » View

Travel Authorization Details

Robert Lightfoot
¥ General Information
Description

Business Purpose

User Defaults

USG Faculty Counal
Aftend Meelings

Status Ciosed
Destination Location ATLANTA
Date From 031872009 Date Te 03202009
Accounting Defaults
Details
Date *Amount Currency
Lunch 03/19/2009 S.00USD
Dinner D3ns2o08 2000USD
Lodging 8810 USD
Break st 7.00USD
Lunch 8.00USD
Dinner 20.00 USD
Parking 03 00g 10.00 USD
Totals
Authorized Amount 164.10 USD
Less Non-Approved 0.00 USD
Due E mployee 164.10 USD
¥ Action History
Role Hame

18t Level D ept Manager
st Level D ept Manager
Reviewer

(& Return to Search

t.| Previousin List & |

Lightioot R obert
Hendroc C Anthony
VanDenHende Mark
Palmer,David Allen

Nexd in List

|3
Z
2

Home Worklist Add to Favorites Sign out

New Windo

Authorization ID
Comment

B500300029

Last Update Dttm 0/05/2009
12:00:00AM

By HOBMTHAW

Personalize | Find | 8 | B First' & 1.7 of7 & Last
*Payment Type “Billing Type
Cash ntemal "Detail
Cash ntemal *Detail
Visa ntemal "Detail
Cash intemal *Detail
Chedk Intemal *Delail
Cash ntemal *Detail
Cash intemal *‘Cetail
Personsize | Find |00 | B Fiest 0 140140 Last
Action Date/Time
Submitted 03022009 11:50: 284N
Approved 0022009 12:24:56PN
Approved 0052009 5:19:09AM
Reviewed 0052008 8:22:424M




Printing via Browser
View the Cash Advance,

File > Print

View

Favorites Main Menu

View Cash Advance

Craig Young

Travel and Expenses ~

Business Purpose Athletic Events/Team

Advance Description Final Four

Accountng D_lle 0672172009
Cash Advance

& ViewPrintable Version

*Source Description

Employee Advnce EFT Paymenis

Totals

Advance Amount

meal money for state loumamen

1,500.00 USD

Cash Advance ~

View

Repori
Reference
Post State

Created
Last U pdated

Home

2400300075 Reconcied

Posted
0870572009
06/21/2009

Craig Young
Angela Veal

F& UserDefults

@ Motes

& By checking this box, | certify the advances submitied are accurate and comply with expense policy.

¥ Approval History

Fole

1st Level Finance Dept M anager
1st Level Finance Dept M anager
AP Payment Approval - Rept Ver

2" Returnfo Search | *_| Previousin List

Name

Youn g.Craig

Eve Christopher E
Foskey,Linda F
Khanna, Aman

o] MexinList

'_-3]

Payment

Submitted On
Submitted By

Action

Submitted
Approved
Approved
Approved

*Amount Cumrency

1,500.00USD

050572009

DateTime

05052009 10:11:3440
050572009 10.50:452M
050572008 10:54:124M
05/0572009 1:37:39PM

Page 1 of 1

Add to Favorites Sign out

New Windo




We welcome your feedback on any of these
reports and processes.

Please notify Kate Smith kate.smith@usg.edu with
any comments by Wednesday, November 26.




Institutional Retrofits
e Database level access (PSQUEST)

— available in December for retrofitting of institution
developed interfaces and reports.

 PeopleSoft Query access

— available during UAT (February) for retrofitting of
institution developed PeopleSoft queries.

* Tools to be provided 15t week of December:

e Cheat sheet of record changes.
* Query Jumpstart Report.



Please Respond!

Do you use the ITS provided Workstation
Installer? If so, what for?

 Email Response by Friday, November 215 to:
michael.casuccio@usg.edu or paige.born@usg.edu

e After the upgrade, a workstation install will only
be necessary if you create custom nVision
reports.



Questions?






